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Setting Up a Yachting Membership Registration Form
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Registration forms can be setup and sentto existing as well as new members to allow them to 'self-register' for a season.
Products can be added to registration forms so payments can be taken online.

NOTE: You must Edit the National Registration form Template to create registration forms for all Club and
Class Association Registrations.

To set up a Membership Registration Form,complete the following steps:

1. Click on ‘Registrations' and then 'Registration Forms’in the menu along the top on the page.
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2. You will then come to the Registration Forms menu. You will need to Edit the "Member to Association" National
Registration Form template for Clubs/Class Associations. Click on Edit to configure the form.

Note: Do Not Add a NewForm

Registration Forms

Parent Body Forms

Mational Registration Form Template for Clubs { EDIT this Form to set up Club Registration Form [#41968)] Member to Association | SET PRIMARY View Edit

National Registration Form Template for Discover Sailing Day [#41984) Member to Program SET PRIMARY Edit




3. You will be presented with the screen where you can configure the National Registration Form for your Organisation.
The 'Settings' tab will be selected. Fill in all fields where necessary on the Settings tab and click Save.

Registration Forms » Edit » Settings

National Registration Form Template for Clubs - EDIT this Form to set up Club Registration Form
(#41968]

Fields Layout Products Messages

Save

Form Name: National Registration Form Template for Clubs - EDIT this Form to set up Club Registration Form
Type of Form: Member to Association

Form Enabled Yes

Payment is Compulsory [[This option should be set only if payments are enabled and you have merchant account set up.]

Payments are not enabled. Contact support if you feel this is incorrect.

A Merchant account has been set up.

Bank Account has not been verified. Contact support if you feel this is incorrect.

When this option is set and if there is at least one mandatory product, then he/she will not be able to complete the registration process. CLICK
HERE to see how to make a product mandatory.

Allow Member to Register
as:

Adult

Youth

Social

Discover Sailing Participant

Allow multiple registration  [MPORTANT NOTE: This will allow you to register and pay for multiple people at once. You need to check the boxes below to allow multiple adults or
(family registration process}: children [or both) to be entered using this process.

Using this process, some details from the initial person’s registration will be copied to the subsequent forms, and a single payment will be made
covering all the registrations.

M Allow multiple adults to register?
bl Allow multiple children to register?

Registration Options: Allow all registrations

Save

Form Name: The name of the Registration form - this will be locked for the National Registration form Template.

Type of Form: 'Member to Association' indicates that the form will be registering members to the Club or Class
Association setting up the form.

Form Enabled: This option will activate or inactivate the online registration form. This is not editable using a National
Registration form template.

Payment is Compulsory: If you wantto make itcompulsory for someone to purchase a productin order to complete
registration, tick this box.

Allow Memberto Register as: You can selectthe Member Record Types people can register as on this form. If you do not
complete this step, you will not be able to activate the form.

Allow multiple registration (family registration process): If you wantto allow multiple people (Adults & Children) to
register on a single form, select these options.

Registration Options: Choose who you wantto allow to register via the registration form.
» Allow all registrations: Anyone can register via this registration form.

o Allow new registrations if not in the national system: Only members who aren't
currently in the national database can register.

o Allow new registrations only if in national system: Only members who are currently in



the national database can register.

o Allow existing members only: Only allows members who have their Username and
Password to register again.

o Allow new registrations only: Doesn't display the Username and Password login and if
Duplicates are found with this person then the member won't be allowed to proceed.

o Allow new only if already in the association: This will allow new members but only if
they are already entered into the association database.

4. The nexttab is the Fields tab: This tab will allow you to set what fields or questions display on your registration form.

Note:Fields set at State Association level willimpact on the fields that are available for Registration Forms
in a Club level database. For example, if First Name is set as Compulsory in the State Association level
database, a club will have to display that field as compulsory on their Registration Form.

National Registration Form Template for Clubs - EDIT this Fq
(#41968]

Settings Layout Products

Choose the the visibility and editing options for each of the available Member fields.

Save

Field Mame Hidden Read Only
YA Mumber O
Member Number .

Active in Club ® O
Salutation

Legal first name

Middle name O O
Family name
Maiden name Ol O

» Hidden: This means the field will not display on the registration form.

o Read Only: This means that the field cannot be edited by the member but can be viewed.



« Editable: Editable means that the field will display on the registration form but it will be an
optional field.

o Compulsory: Compulsory means that the registration form cannot be completed without
this field being completed. It will be marked with a red star on the registration form as a
compulsory field.

o Add Only (Compulsory): Add Only Compulsory means a member will need to complete
the field, but once it has been Added it will not be able to be changed. Generally this field is
used for date of birth, where someone’s date of birth won’t change in the manner that
say surname, address, phone number may change over time.

5. Layout Tab: The Layout menu will allow you to configure the order in which your fields will display on your registration
form. To arrange where a field displays on the registration form, click and drag the field and drop itto move itinto a position
on the form. It will save automatically.

The layout menu will also allow you to add a text or header block on your registration form. You will be able to:

« Add Header Block: This enables you to add a label for a group of fields on the
registration form.

o Add Text Block: This is where you can add a description of a group of fields on a
registration form.

« Edit the Display Rules of a Field: For any fields that you have added to a registration
form, you can set up rules determining who they display for. For example, you could set a
rule that would only allow the 'Parent/Guardian’ field to display for people who are under
18 (based on the DOB they enter).

« Editing Header/Text Block: You can edit the the details in a header/text block that you
have added.

Settings Fields Layout Products Messages

Reorder the fields by dragging them to position. The new order is saved automatically.
Extra blocks of headers or text can be added by clicking the respective buttons.

ADD HEADER BLOCK ADDTEXT BLOCK

H-Block => Personal Details

YA Number

Salutation

Date of Birth - Step 1

Legal first name - Step 1

Middle name

The screen below is what the set up for a Heading Block or Text Block will look like. Enter in a label for the block and then
enterin the ‘Block Content’ for what you want to display on your registration form.



National Registration Form Template for Clubs - EDIT this Form to set up Club
(#41968)

Settings Fields Products Messages

Block Label:

Block Content:

Save Header Block

6. Products Tab: The Products tab will allow you to link previously set up products to your registration form. Any products
that you tick in the ‘Active’ column highlighted below will display on your registration form.

Settings Fields Layout Messages

Choose which products to make available for selection on the registration form by checking the corresponding "Active’ box.

Save

Active Mandatory [i| Sequence [i] Group Product Name Price
O O Event Entry Fee 100.00
O O Xmas Part Event Fea 5.00
O O Events SSS/RYA Instructor Convention Option 3 100.00
| O Events SSS/RYA Instructor Convention Option 4 100.00
O O Events SSS/RYA Instructor Convention Option 5 100.00

Making a Product Mandatory: On this screen, you can also choose to make a product mandatory on your registration
form. To make a product mandatory tick the box for the specific product that you’d like to make mandatory.




Settings Fields Layout

Choose which products to make available for selection on the registration form by checking the corresponding "4

Save

Active Mandatory [i|] Sequence [j] Group Product Name

I vi Event Entry Fee

i L] Xrnas Part Event Fee

I L] Events S5SS/RYA Instructor Convention
L] L] Events S55/RYA Instructor Convention

Product Sequence: The Product Sequence column will allow you to order how your Products display on your registration
form. It will order your products numerically. If you don'twish to sequence/order your products, simply leave them blank.

Settings Fields Layout

Choose which products to make available for selection on the registration form by checking the corresponding "Ad

Save

Active Mandatory [i| | Sequence |[i] Group Product Name

¥ Vi 1 Event Entry Fee

] L] 3 ¥mas Part Event Fee

] L] 2 Events SSS/RYA Instructor Convention

7. Messages: The Messages section allows you to add in Messaging on your Registration form. There is pre-settexton all
Sections of the National Registration form. The Messaging the Clubs & Class Associations can configure is the Terms &
Conditions found under the Full Information tab. A Club or Class Association can insert theirown Terms & Conditions and
include an "l agree to the above Terms & Conditions" mandatory checkbox. Save the changes made to the registration form
by clicking the green Save button at the top or bottom of the screen.




Settings Fields

Save

Customise the text that displays at various stages of the registration process.

H Choose Type H Initial Information

Full Infermation

‘ Summary H Credit Card Payment H Confirmation Email

T&Cs

This text will appear at the top of the "Full Information’ page.

This text will appear at the bottom of the "Full Information® page, above any Terms & Conditions or Opt Ins.

This is where any Terms & Conditions should be entered, the smaller of the two boxes being for an optional header.
The T&Cs will appear at the very bottom of the ‘Full Information’ page, under the product selection area.

[] Include an "| Agree to the above Terms & Conditions™ mandatory checkbox?

Save

8. Viewthe registration form: Click on 'Registration Forms’. You will then be able to view the registration form you
have edited. To make the registration form available to your members, simply copy the URL and distribute/create links as

required.

Registration Forms »Edit » Text Messages

National Registration Form Template for Clubs - EDIT this Form to

(#41968)

| Messages saved




Registration Forms

Parent Body Forms

National Registration Form Template for Discover Sailing Day [#41984)
Association Forms

Event Registration Form [#43836)

SS5/RYA Instructor Convention July 6 - 8 [#44691)

Mew Registration Form [#44767]

Member to Program

Member to Event

Member to Event

Member to Event

Mational Registration Form Template for Clubs - EDIT this Form to set up Club Registration Form [#41968] Member to Association | SET PRIMARY -

SET PRIMARY

Edit

Edit

Edit

Edit

Edit

Forfurther assistance please contact Online Services:
onlineservices@yachting.org.au

0284247400
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